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Introduction

TuxShop is a modern point of sale and shop management applica-
tion, that is supported on Linux(tm) and Micosoft Windows(tm).
It is feature packed yet still manages to provide an interface that is
as simpler than a cash register to operate. As your business grows
you will need a solution that will grow with you. With TuxShop
you get a choice of using a touch screen interface or the traditional
keyboard interface, and indeed it is possible to use both !

In addition Linux support offers reliability,stability and long term
support at levels most people can’t imagine, scaling with thin clients
keeps hardware costs to a minimum. Mixing of Windows and Linux
or a Linux only or Windows only environment is also supported.

A comprehensive selection of reports will assist you with the man-
agement of your business.

Support

Via E mail at info@tuxsoft.co.za Be sure to include your support
details in your email. In some areas you may have telephonic sup-
port.

Bugs

You can send all bug reports to info@tuxsoft.co.za via email. Users
with a valid support option will get a reply and a projected fix time
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rapidly, and yes we call problems bugs, we fix bugs !



1 Installing TuxShop

1.1 Computer Requirements

| Operating System | UBuntu 18.04 or 20.04 LTS/ Microsoft Windows

Processor AMD Ryzen / Intel 13 - Or better
Memory 1GB Min, 4GB or more recomended

Display 1024x768 Minimum / 1280x1024 recomended
Network 100Mbit or better

In addition the usual peripherals such as mouse, cdrom, etc. are
required. The above specifications may be replaced with higher per-
formance hardware at your leisure.

1.2 Windows Installation

Simply insert the TuxShop CD into your CD-Drive. The TuxShop
installer should start automatically, if not your windows installa-
tion is not standard and you should have the skills to start the in-
stall. If not contact your system administrator. Note that through-

out this manual the TuxShop directory refers to the C:\Program
Files\TuxSoft folder. In addition wherever you see the path /opt/tuxsoft/
you should replace this with C:\Program Files\TuxSoft if you are
running 64Bit Windows use C:\Program Files (x86)\TuxSoft




1 Installing TuxShop

1.3 Linux Installation

Most modern Linux distributions support some form of automount,
and as such the installer should just start. You will need to know
the root password, if not your system admin will need to do the in-
stall. We recommend that you use the KDE environment. Note that
throughout this manual the TuxShop directory refers to the /opt/tuxsoft
directory . In addition wherever you see the path folder C:\Program
Files\TuxSoft you should replace this with /opt/tuxsoft
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Creating a Database

In most cases before you create a database it is necessary to install
a SQL database server, you may choose to use the SQLITE option,
if you will run a single Linux or WindowsPC. With Linux it will
be possible to use multiple stations if using thin clients. Supported
database servers are MySql, Postgresql, and most ODBC interfaces.
You can obtain a copy of MySQL for Windows from http://www.mysql.com/
or from the contrib folder on the CD. We recommend you use a
Linux server running MySQL.

After installation you should find a dbTuxShop entry in your sys-
tem’s start or K menu. The dbTuxShop utility is used to configure
and populate a database for TuxShop.
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1 Installing TuxShop

Figure 1.1: Database Setup Page 1

TuxShop Databose 5

Welcome

This wizard will assist you in getting your database and database
connection for TuxShop up and running

In addition you will be able to install some sample data or restore &
backup, and begin to experience TuxShop right away

You can alsa use this wizard to configure TuxShop to use existing an existing
database.

RedHat Issues

If you are intending to use PosgreSQL you will need to enable tcp-socket
connections in /var/lib/pgsqlfdata/postgresgl. conf

TUXSOFT

SIMPLE SOPHISTICATION  “="L

The first page in the dbTuxShop wizard will inform you of any spe-
cial requirements or useful information relating to your server type.
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1.3 Linux Installation

Figure 1.2: Database Setup Page 2

I TuxShop Dotabase Setup 2

Server and Database Selection

Choose the datasbase server type you will be using with TuxShep, and enter
the hostname or IP running this server. (Not used for QSQLITE)

Only MySQL, PostgresSQL, and SQLite have been tested

~Server and Driver
® QMYSQL3
) QSQUITE
() QSQLUITE3

(O opPsQLY

() QODBC3

Server I\acalnost

~Database

user[‘ruxshun

Password s

Namel‘ruxsnan

[ <Back | [(Next> | | cancel |

On page two you can select your server type, host, Database user
name, Database user password, and database name. Not all database
servers support password protection, this is especially true on win-
dows platforms. When using SQlite the database name is a physical
path to the database file. Make sure you have permissions to read

and write to the location you choose.

When installing under Windows 98 you must use your computers
name. With windows XP you must use localhost or the physical 1P

of your PC.

Linux makes use of any valid name or IP address.

13



1 Installing TuxShop

Figure 1.3: Database Setup Page 3

TuxShop Database:

Administrator Details

You now need to enter the Name and Password of your database
administrator.

The TuxShop database and tables will be created using the administrator
details you provide here

These fields are ignored when using SQLite

Administrator Name [root ]

Administrator Password [t ‘

| <Back | [ mext> | [ cancel |

In most cases you will need to supply a name and password for

your database administrator. This is usually NOT the system root
password.
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1.3 Linux Installation

Figure 1.4: Database Setup Page 4

i You must now select the tasks you would like the wizard to perform.
[
/

After this your TuxShop installation is complete

[ Create the TuxShop Database :
[X] Update configuration files

[%] Restore data from backup

l < Back l [ Hext> | [ Cancel ]

You may use the dbTuxShop utility to restore a backup of your
database, or you can populate it with sample data from the backup
samples provided. When you first install TuxShop it might be a
good idea to populate it with sample data so that you may learn and
play with the system before committing to a running live system.
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1 Installing TuxShop

Figure 1.5: Database Setup Page5

Progress

]

Creating Database Structure

An indicator showing the progress of the create and populate phase
is shown, the actual time depends on the type of server and size of
your database.
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1.4 Starting TuxShop

Figure 1.6: Database Setup Page 6

I TuxShop Dotabase Setup 2

Congratulations

You have succesfully Installed your TuxShop database.
When you first run tuxshop you must use the default admin password of
' tux
| )] .

) Select Edit , Preferences to add Personel and fine tune your TuxShop
instalation.

Click Finish to close this dialog

TUXSOFT

SIMPLE SOPHISTICATION <=4

[ | [ ] Lo |

You are now ready to run TuxShop, you need to take note of the
Admin password if this is an empty or sample data install.

1.4 Starting TuxShop

You can start TuxShop from the TuxShop menu in the KDE or Win-
dows start menu. In most cases there will also be an icon on your
desktop that will start TuxShop. When running TuxShop for the first
time you will need to log in as the Admin using the login code of
tux this can be changed using the Edit -> Preferences menu.

17






2 Preferences

2.1 Sysinfo

Figure 2.1: SysInfo Page

TuxShop Preferences - 20 X
SysInfo [ personnel | Printers & Email | Misc | License ]
—Stare Name ~Language
esty Tuxshop /|| (Engsn 7]
—Tax

[ ndusve |
[CKOO,’DOOOO,‘DO l Mode |Inclusive n
|p.0. BOX 0000 | ley
[Tuxvinle ||| name [var
|oooo |
|00o0-0000,0 |

|

[VAT No 0000000000

—Receipt Footer

Levy |0.0000

[Thanks for this payment l
~Invoice Footers —Price Categories
[<b>We hope you enjoyed your meal, please call again.</b> l Base Price ——————————
[Have you tried our vegitarian range ? Its tasty and Healthy l Name |DINE IN

Markup 1.3000
—Statement Footers

~Tier ]l ——————————

[Note: We do not carry accounts.

[Any account at 30 days will be handed evedr for legal action.

[

Name | TAKE AWAY
Markup 1.4950

—Hand Over Footer

[THIS ACCOUNT HAS BEEN HANDED OVER FOR COLLECTION

~Tier2 ————

MName |WHOLESALE

Markup 0.9000

=
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2 Preferences

The System Information page is used to configure your business
details, tax settings, and footers for various customer documents.

Facility is provided for two tax levies in either Inclusive or Exclusive
modes. If a tax levy does not exist simply leave its name blank and
its value at 0.0000 and TuxShop will ignore it.

Your License or Lease is linked to the first line of your address. This
must be the trading name of your business, if this changes you will
need a new License or Lease key.

As can be seen for the sample data it is possible to use trivial HTML
markups in the footer fields to achieve a more dramatic effect.

Language - the GUI and documents may use a specific language
catalogue. See the section on customisation for more information
on creating a new language.

Price Categories - TuxShop supports up to three price tiers, you
may name these as you desire, and set the default markup for each
tier or category. If the tier name is left blank it Will not be available
in sales operations.

Discount Matrix -

2.2 Personnel

The Personnel page is used to add and manage personnel and their
privileges within TuxShop.

20



Figure 2.2: Personnel Page

2.2 Personnel

TuxShop Preferences A&

SysInfo | Personnel IPrinters & Email |Mi5c |Licanse }

rUsers

Ross Linder
Admin

Delete

Update

(- Commision

Y%

@

Cash Account

~GUI Style

—Permissions

[Default

|v] %] Mail Statements

[ Email Runs
[%| Backup Database

B o

¥ cash Date

[ Month End

(% Add/Modify Clients
(% Merge Clients

%] Purge Clients

[%] Manage Inventory
[%| Manage Departments
(% Manage Suppliers
[%] Access Documents
[] view Action Report
(%] view Reports

%] void Invoices

X view Audit Trails

[X] view Journal Trails

% view Statements

[XI Discount Sales

[%| Modify Preferences

[ Tax Control

|| Price Overide

[ ] Allow Unvalidated Items
[%] sticky Cash Acc

[ cash Acc Only Lock

%] Allow Refunds

[%| Order Stock

[X] Receive Stock

[%| Adjust Rec. Stock Prices
%) view Stock Prices

% void Receipts

lO (2]
| III g‘
o

When you first run TuxShop there will only be the Admin personnel
entry. Admin can not be deleted, however you should change the
Admin password. To do this simply type in the new password into
the Code field then click on the yellow Update button.

The next task will most likely involve adding a new personnel entry.
To do this click on the green New button. You will be presented
with a sequence of prompt dialogues as follows.

21



2 Preferences

Figure 2.3: New User Name

i New User A

Enter the new users name

Docs

The name you enter for the new user is the name that will be shown
in the Personnel users list and in the action log.

Figure 2.4: New User Initials

i New User A

Enter the users SP initials

DC

The initials are used in the Sales page to identify the sales person
and calculate any commission on sales.

Figure 2.5: New User Code

4 New User A&

Enter the user Login code

Lastly you will enter the users code. This is the code the user will
use to login to TuxShop, all preferences and settings are linked to
the users code.

After adding a new user to personnel you can fine tune the various
preferences allocated to that user. These are described in more detail
here.

1. Commission - this value specified in percent is used to accu-
mulate commission on sales and applied to the pre-tax amount.

22



10.

11.

12.

2.2 Personnel

Cash Account - In some cases it may be desirable to have a
given user associated with their own cash sales account. This
would be needed if your installation has more than one POS
terminal. Cash accounts must start with the word CASH in
the account name !

. GUI Style - This is just a modern day graphical gimmick, eye

candy to waste CPU !

Mail Statements - Checking this option will enable the user
to print or email statements to all customers with a debit bal-
ance.

Email Runs - This option should be disabled as it is not yet
implemented.

. Backup Database - Checking this option will enable the user

to create backups of the TuxShop database.

Cash Up - Checking this option will enable the user to per-
form the daily cash up and / or view the current cash situation.

. Month End - Checking this option will enable the user to

print out a month end report.

. Receive Stock - Checking this option will enable the user to

accept stock and enter it into the system.

Adjust Rec. Stock Prices - when checked the user will be
able to adjust prices of items when stock is received.

Purge Clients - Checking this option will enable the user to
purge a customers account. All records will be removed from
the system, you will have an option to produce a printout for
back reference.

Merge Clients - Checking this option will enable the user to
merge two customer accounts into one. Useful when couples
get married, or when names differ slightly and two or more

23



2 Preferences

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

24

accounts have been created for the same customer. For exam-
ple Byte and Pieces, and Bytes and Pieces CC.

Manage Merchandise - Checking this option will enable the
user to add and edit Merchandise that you stock.

Manage Services - Checking this option will enable the user
to add and edit Services that you perform.

Manage Suppliers - Checking this option will enable the user
to add and edit suppliers known to your company.

Order Stock - Checking this option will enable the user to
activate the stock level and ordering process.

View Reports - Checking this option will enable the user to
view any of the available system reports.

View Audit Trails - Checking this option will enable the user
to view and print a complete audit trail of a given account, any
notes will be shown in this trail.

View Journal Trails - Checking this option will enable the
user to view and print a journal trail for a given account.

View Statements - Checking this option will enable the user
to view and print a customers statement.

Discount Sales - Checking this option will enable the user to
discount invoiced items.

Modify Preferences - Checking this option will enable the
user to do anything.

Tax Control - Checking this option will enable the user to
enable or disable tax levies on a item to be invoiced.

Price Override - Checking this option will enable the user
to override the price of an item that was retrieved from the
database.

Allow Unvalidated Items - Checking this option will enable



26.

27.

28.

29.

30.

31.

32.

2.3 Printers & Email

the user to invoice items not in the database, to be effective
the user also needs price override and tax controls.

View Action Reports - Checking this option will enable the
user to view and clear the action log. The action log contains
a history of any operation the user performs that is not normal
operational procedure.

Cash Acc Only Lock - Checking this option will lock the
system to use only the cash account associated with this user.
Typical applications might be cash only take away food ven-
dors.

Sticky Cash Acc - Checking this option will make the default
account the cash account associated with the user, however
the user will still be able to select a client if needed.

Refunds - Checking this option will enable the user to accept
returned goods for refund.

Access Documents - Checking this option will enable the user
to view and manipulate the Documents page.

Void Invoices - when checked, the user will be able to void
an Invoice.

Void Receipts - Checking this option will allow the user to
void a receipt.

When changing the active user settings the changes will become
effective after a second or two. Language and style changes should
be immediate.

2.3 Printers & Email

TuxShop currently uses three printers. Physically these may all be
the same printer or multiple printers at various locations.

25



2 Preferences

Figure 2.6: Printer and Email Settings

TuxShop Preferences

SysInfo Printers & Email | Misc | License

i Invoice  Company Logo
Printer [Iaser ” Setup .. ]
¥
Mode ® Logo () Page () Slipgo () Slip40 [X| Preview Tl 'XSOFT ’I
)]
[ Receipt SIMPLE SOPHISTICATION 9%
Printer [Iaser ” Setup .. ]
Mode ® Logo () Page () Slip8o (U Slip40 [%| Preview Browse ..
Printer [Iaser H Setup .. ]
<b> [27,71,33
Mode ® Logo () Page () Slip80 (U Slip40 12
</b> |27,71,32
Jr—— <d> [27,33,15,27,33,32 ]
Printer [stylusphoto1200 || setup.. | </d> [27332 ]
Mode ® Off () Page () Slipgo (O Slip40 [X| Preview cems l27 138 ]
<fem>  [27,33,2 ]
 Email [ ]
(|| Printer Init
s s 2575100 e s[5 " | ]
Email Address |infu@lux5uﬂ,(u,za End of page [29,86,1,1,30,30,30
Cash Draw [27,112,43,55,121 ]
 Page Colors ]
Text Red Blue Dark Blue
Background Background Backgroun

The Invoice, Receipt and Kitchen printers are self explanatory and
used to print Receipts and Invoices. When enabled the Kitchen
printer can be used to create order slips for your kitchen is appli-
cable. The mailing printer is used to print all other customer doc-
umentation. Typically these documents would be posted to your
customers.

You may also choose to use a logo in your documents, you should
only choose logo’s that are of a reasonable size. The actual printer
configuration is system dependent, but should be familiar to most
people.

In order to email documents to customers you need to be able to
connect to a SMPT server, the Email settings allow you to choose

26



2.4 Misc

the server and port number to connect with. TuxShop can not keep
mail spooled waiting for an SMTP server. To use email the server
must be on-line.

2.4 Misc

The Miscellaneous page contains settings for the backup media writer
and the selections of fast cash banknotes. Bank notes can be used to
speed up and reduce errors in the receipt process.

Figure 2.7: Misc

TuxShop Preferences  Af

Sysinfo | Personnel | Print‘ers @ Email | Misc | License |

[ Touch Interface | | Qty Check [ | Take Out Change [X Invoice Info. [ | Strict Stock [ | FullScreen | | Log Actions

(S Pre Process Invoice Message
k

ml=>Speak to the customer in <b><i>THEIR LANGUAGE=</i></b><br> Not yours |, be polite at all times.<,’htm|>"

Rounding D Interest on Arrears D Max statement days
r{eport Preview

Font Sizels = scaling|1 3] width 530 2] Height|ss0 |2 Lines|48 F],I
Preview Window Button Colour Mode
Font Size s width a Height ”O Mo Colours () Text Colours @ Button Colours

(Serial Cash Drawer
P

ort| SLIP40 |~ Speed| 1200 ~ |l DTR-DSR

Epson DM-D Display Pole
(Serial Port| COM2 |~ |Speed| 9600 ~ [%| DTR-DSR

 Bank Notes

@

2 rVaIue[200 ]

By checking the Show Touch Interface by Default check-box, the
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2 Preferences

sales page will start in touch screen mode, if unchecked the key-
board interface is shown by default.

When the Qty Check option is checked, the quantity field in the
sales keyboard page will automatically get focus and highlight after
an item is scanned or located in the Item combo box. This is useful
in businesses where the quantity of items is often not 1.

When the Take Out Change option is checked, a dialogue prompt-
ing you for change provided is presented when the invoice is pro-
cessed. This allows a note to be added to the Invoice that is useful
for take out orders where change is sent with the delivery.

When the Invoice Info option is checked, a dialogue allowing you
to enter additional info to be displayed under the account name is
presented when the invoice is processed. This is typically used to
add customer details or delivery instructions to cash sales.

Whet the Strict Stock option is checked items can only be vended/sold
when there is a sufficient quantity in stock.

When the Full Screen option is checked the interface will be run
in full-screen mode without window decorations, usually prevent-
ing the operator from accessing the operating systems task bar and
menus.

When the Log Actions option is checked, all actions and operations
are logged into a system log file that can be viewed from the reports
menu. If checked it is important to view and clear this log on a
regular basis as the size of the log grows rapidly.

The Backup Media App. can be any command that will take a
file and write it to a backup medium. The %1 is replaced with the
backup file name you specify at backup time.

The Online URL is the URL used to update your online store stock
levels and prices, for more information on this contact TuxSoft.

Bank Notes can be changed simply by clicking on the note or empty

28



2.5 License

button, the Value field contains the value associated with the note.

Rounding allows you to round down your invoices to the nearest
cent in rounding value. For example to round to 10c intervals use
10, to round to the nearest Rand use 100

Interest on Arrears select the interest rate in % for account in ar-
rears.

Max statement days will determine the number of days an account
goes overdue before statements are no longer automatically mailed.

Report Preview panel provides settings to match your printer to
the on screen display, you can change the font size and adjust the
scaling to provide a display that is visually acceptable on screen as
well as on the printout.

Preview Window panel provides settings to change the size of the
text on your preview and printouts , as well as adjust the preview
windows for optimum size on screen.

Button Colour Mode panel if you are using windows Xp, you will
most likely want to use the Text Colours option since Xp does not
support colours in buttons. For all other platforms choosing but-
ton colours will most likely be your best option. This is however a
personal preference and does not affect the operation of TuxShop.
Epson DM-D Display Pole these settings determine how a display
pole, if any, is attached to the system.

Cash Drawer these settings determine how a simple serial cash
drawer, if any, is attached to the system.

2.5 License

The license page provides fields where you can enter your number
of tills and license key information. Once a valid key is entered the
3 customer limit and watermark on printouts will be removed.

29



2 Preferences

30

Figure 2.8: TuxShop License

Sysinfo | Personnel ‘Printers & Email ‘Misc ||__icense

TuxShop 2.8
Shop: TuxSoft CC
Granted Rights

You may install this software onto any number of computers at any location. Your license key will determine how
many concurrent till points may be active at any time.

Limitations of Liability

In no event shall the developers or copyright holders be liable for any damages whatsoever, including - but not
restricted to lost revenue or profits or other direct, indirect, special, incidental or consequential damages, even if
they have been advised of the possibility of such damages, except to the extent invariable law, if any, provides
otherwise.

Warranty

The Software and associated documentation are provided AS IS with NO WARRANTY OF ANY KIND, INCLUDING THE
WARRANTY OF DESIGN, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Expiry 2010,:‘03,:‘31|Z]‘ Option |0




3 Basic Operation

Figure 3.1: Basic Keyboard Interface

File Edit View Help

TUXSOFT §

Ph:+2782389 3451  Rttpy/www.tuxsoft.co.za

Next Customer - Please ‘

F9 Sales Receipt | Documents Client

7 F2 | Fi1 Department Selection Invoiced Items

Qty. | Description Disc.% | Amount
S/P |D Cat. | Inventory |~ Clear
o -
Code l— Quote

F3 Ret : Deposit
s/N Return
@ Goods
Qty. [1
Less % Unit Price.

F8
] »]| Process

i ii-0-cf 0

In this chapter we describe the basic operation of TuxShop from the
moment a customer walks in your door till they leave after paying.
If your business is a cash only business you might consider using
the Cash Only Lock preference.
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3 Basic Operation

Figure 3.2: Touch Screen Interface

. Tuxshop A&

File Edit View Help

TUXSOI’T]

IMPLE SOPHISTICATION  “%
Ph: +27 82 389 3451  http://www.tuxsoft.co.za

Next Customer - Please

FoSales | Receipt | Documents | Client |

) F2 | F11 Department Selection Invoiced Items

Qty. | Description | Disc.% | Amount FS
& 9 . ¥

6
Top Level

¢ /;;J Return
Goods

GOLF BALLS CLUBS LADIES CLUBS GLOVES

# &S ' ¢

LADIES GLOVES SHOES LADIES SHOES BAGS

" =
= -~ o =
GENTS CLOTHSLADIES CLOTHS TROLLEYS ACCESSORIES
i - 2
- EE
GREEN FEES | SPECIALS al TTv) Process

ci-02-ci 0HM3

3.1 Sales

In the Name field you can fill in the customers name or part thereof.
Focus can be changed to the name field using F1, Thats pressing the
F1 key.

After entering the name or part thereof press Enter if a match is
found it will be displayed in the combination box. If more than
one match occurred, pressing F4 will drop down a list of available
matches. If using our sample data try D you should get a match of
D. DUCK’O

Now you are ready to invoice, select the item field in sales by press-
ing F2 and then type GREEK followed by Enter as we would like
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3.1 Sales

to add a GREEK SALAD to the invoice. Either press Ctrl+A or
click the Add button, you can also just press Enter, the Quantity
field will then have focus, you can change the quantity if required,
pressing enter again will add the item. Note that if the Check Qty.
option is not set in preferences, the system will automatically add
one unit to the invoice when Enter is pressed bypassing the quan-
tity field, this is commonly used with bar code scanner systems.

This behaviour can be changed in preferences in the Misc section by
checking or unchecking the Qty Check button. When unchecked,
enter will add a single item immediately as was the case in Version
2.0 and before.

Next we would like to add a Californian pizza to our Invoice, this
time however we will use the product code, type 35 and press Enter.

To change the quantity of items to sell on the touch interface, touch
the quantity button then the required number of items. The delete
button will erase the last digit entered. The quantity can be seen in
the Quantity indicator on the right of the Qty. button. Once correct
press the OK button, then choose the product button.
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3 Basic Operation

Figure 3.3: Quantity editing on the Touch Interface
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We can now process our invoice by clicking on the green Process
button or by pressing F8 our invoice is presented for printing.

Should we have enabled the Take Out Change option the follow-
ing dialogue will be presented where we may enter an amount for
change to be provided for. Leving the amount as O or by selecting
cancel will not add a change note to the invoice.
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3.1 Sales

Figure 3.4: Change For Dialogue
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When the Invoice preview is presented, assuming previews are en-
abled, choosing any option on the Preview other than Close will
process the invoice into the system. The Receipt page will automat-
ically raise in anticipation of payment.
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3 Basic Operation

3.2 Receipt

Figure 3.5: Receipt Page

If enabled you can use the fast cash bank notes to enter an amount
responding to the physical bank notes tendered by the customer. You
can also fill in amounts by hand, if payment is made by Cheque or
Credit Card the exact amount owing will be filled in when the pay-
ment type option is selected. In addition a further field will become
enabled to allow you to enter the cheque or card number.

When a return for refund is processed, the amount tendered field
will contain a negative value indicating the value to be refunded to
the customer. If you would like to leave the amount as a credit in
the account you can simply ignore the Receipt phase, press Ctrl+L
to clear and return to Sales

If the client would like to leave the change as a credit or you receive
a deposit (down payment) then simply check the Keep Credit op-
tion, this will leave the account in credit and set the change due to
0.00
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3.2 Receipt

You may also choose to ignore certain invoices when receiving pay-
ment. To do select only the applicable invoices in the selection list
as you do this the amount owning will change to reflect the new
selection. By default all invoices are selected.

When ready you can click the green Process button. After accepting
the presented document the system will clear and again be ready for
sales.
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4 Advanced Operation

4.1 Sales

Depending on the preferences settings it may be possible to alter the
selling price, whether tax is applicable on an item, and to apply dis-
counts. All these features are self explanatory. You can also change
the Department selection, two special cases exist for Notes and Re-
marks, Notes are private and will only appear in audit trails and are
intended for your personal records. Remarks are printed on the In-
voice and intended to inform the customer to related information.

4.1.1 How Item searching works

The Item field is a very versatile tool, you can search for products
by name, part thereof, or item code. When more than one product
matches the description you can drop down a list of matches or scroll
through the list using the arrow keys. When scrolling through the list
the item code indicator will update with each items product code.

When connecting a bar code scanner to your system, you should
program your scanner to append a CR (carriage return) to the end
of the bar code, this will have the effect of automatically adding the
item to your invoice. To add multiple items of the same type, first
enter the quantity then press F2 and finally scan the product. You
can also choose to always verify the quantity by checking the Qty
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4 Advanced Operation

Check option in Misc preferences.

Items can be added to the Invoice by pressing Enter or using the
Ctrl+A accelerator, likewise items can be removed from the invoice
by highlighting the required item then using the Ctrl+R accelerator.
The Add and Remove buttons may also be used.

4.1.2 Closing an Invoice temporarily

Sometimes it may be desirable to close an invoice temporarily, this
might be in a restaurant type environment or perhaps a repair or con-
tractor scenario. You would most likely use the clients account or in
a restaurant the table account name. Simply process sales as usual,
when you are presented with the Invoice for printing, select Close,
next use Ctrl+L to clear the system ready for further transactions
on any account. To add new items to an existing invoice, simple
open the account and again process sales as usual. When the In-
voice is presented for printing the new items will be appended. You
can choose to close or process/print the Invoice. Once an Invoice
has been printed or processed it is closed processed by the system
and no further modifications may take place.

In some cases you may wish to edit the items already on a pend-
ing invoice, in this case simply click the Edit button and all the
items will be placed into the sales page and removed from the sys-
tem records, use the remove and add facilities to correct your invoice
then process it again.

4.1.3 Serial Numbers

When invoicing items that have serial numbers, you can insert the
items serial number into the S/N field. You can then use the Edit
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4.2 Receipt

-> Search on S/N .. facility to locate the invoice that had the corre-
sponding serial number. This is useful for warranty claims etc.

4.2 Receipt

The receipt process is simple, but we mention a few points that you
may overlook.

1. Always choose the Payment by method first, this will usually
automate the filling in of the rest of the required fields exclud-
ing Cheque or Credit Card no.

2. When using the fast cash bank note facility, pressing subse-
quent notes add their value to the amount tendered field.

3. Remember you can use Alt+C to get focus to the cash amount
tendered field, and Alt+O to get focus on the coupon amount
field. Clicking the other payment option buttons will fill in
the default payment amount from the selected source. It is
possible to accept payment from multiple sources.

4. When an account is in credit you may simply skip the receipt
process and press Ctrl+L to clear and ready the system for
new transactions.

5. To leave items on account skip the receipt process and press
Ctrl+L to clear and ready the system for new transactions.
The accounts will printed/mailed with the File -> Mail ->
Statements facility, usually done at month end.

6. Bank note setup is done using the Preferences dialogue.
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4 Advanced Operation

4.3 Documents

The documents page is used to view past documents associated with
an account. You can view Invoices, Receipts, Quotes, and Refunds.
Simply highlight the document you wish to view and click the ap-
propriate colour coded button.

4.4 Client

The client page is used to add customers and/or update their details,
the discount fields will not be editable unless the user has discount-
ing privileges.

42



4.4 Client

Figure 4.1: Client Page
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In addition the Client page may be used to search for customers
using any of the available fields. For example to locate all customers
who have a 5% discount simply enter 5 in the associated discount
field then press Ctrl+F or use the Edit -> Find menu option. You
may also use the wild card % character, for example to locate all
customers who have 5 or 5.x use 5%.

You can use the % wild card in may ways, for example to find all
clients who have phone numbers like xxx 375 xxxx or 375 xxxx or
375x xxx the key would be to locate phone numbers containing 375
so we would use %375%

The wild card character is extremely useful when searching ad-
dresses and notes.
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5 The File menu

Whenever a letter is shown as Underlined a simple key press will
select that menu option.

il —§

Admin »

Logout
Exit

5.1 Mail

[ Statements |

5.1.1 Statements

Using this option will search through the system for accounts with
outstanding balances and compile statements for mailing. Interest
is calculated on overdue accounts, and long overdue accounts are
printed with a hand over for collection warning. The collection mes-
sage is configured in the SysInfo page?? of the preferences dialogue.

5.1.2 Email

Currently this option is not implemented and should be disabled in
the Personnel preferences.
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5 The File menu

5.2 Admin

(—Backup ———

Cash Up
Month End
Receive Stock

5.2.1 Backup

This will back up your database to a specified file. Unlike your
database server backup tool, the built in TuxShop backup may be re-
stored using the dbTuxShop utility to any of the supported database
architectures.

In addition the Misc preferences dialogue allows you to configure
an application that will write this backup file to media. In the com-
mand the %1 will be replaced with the file name you choose for
your backup.

5.2.2 Cash Up

The Cash Up facility is used to produce Invoice and Payment Sum-
maries, Invoice Histories, Receipt Histories, and Receipt Summaries
for your daily transactions. It can operate in Preview or Print mode.
When operating in Preview mode, the reports are generated and
can be viewed or printed however no housekeeping is done and the
books remain open for further transactions.

When print mode is selected, the reports are automatically printed
for your Accounting records, the books are closed for the day and to-
tals reset. In addition internally transactions are archived, this keeps
TuxShop running fast and smooth for years and years. You may
only notice delays when retrieving documents or searching for data
that has been archived.
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5.2 Admin

The Cash Up procedure should be run daily, or even at shift changes.

5.2.3 Month End

Month end reports can be generated for any month and year you
require.

Figure 5.1: Date Selection
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The following reports are generated. A Revenue Summary, this lists
the number of clients per day, the total Invoiced, and Received as
well as the average of these per client.

A performance Summary will indicate where your income is being
generated.

A Tax or Vat Summary will give you a detailed tax report taking
into account discounts, bad debt, arrears etc. In addition it reports
the total and percentages of received payments by payment type.
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5 The File menu

5.2.4 Receive Stock

This option will present a dialogue where the operator can enter
details of Stock accepted on delivery.

Figure 5.2: Receive Stock
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The operation is simple and works in the same manner as the Sales
page. The Notes field is only added when Process is clicked as these
note refer to the delivery as a whole and not to a specific item. In
most cases the supplier is automatically located. If you have more
than one supplier supplying an item you should select the correct
supplier in the supplier field.

The results of the Receive stock facility can be viewed using the
reports option.

b

The Notes field is only added when Process is clicked as these note
refer to the delivery as a whole and not to a specific item. In most
cases the supplier is automatically located. If you have more than
one supplier supplying an item you should select the correct supplier
in the supplier field.

The results of the Receive stock facility can be viewed using the
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5.2 Admin

reports option.

The Item field is a very versatile tool, you can search for products
by name, part thereof, or item code. When more than one product
matches the description you can drop down a list of matches or scroll
through the list using the arrow keys. When scrolling through the list
the item code indicator will update with each items product code.

When connecting a bar code scanner to your system, you should
program your scanner to append a CR (carriage return) to the end
of the bar code, this will have the effect of automatically adding the
item to your invoice. To add multiple items of the same type, first
enter the quantity then press Alt+I and finally scan the product.

Items can be added to the Invoice by pressing Enter or using the
Ctrl+A accelerator, likewise items can be removed from the invoice
by highlighting the required item then using the Ctrl+R accelerator.
The Add and Remove buttons may also be used.

When making stock level adjustments you should check the Stock
Level Adjustment box, this will allow you to enter negative quan-
tities to cater for shrinkage or spoilage.

Depending on the users permissions they may be able to view and
update prices and markups.

5.2.5 Cash Date

This produces the same reports as the CashUp function, however it
allows you to choose the date of the day for the desired report. See
Cash Up
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5 The File menu

5.2.6 Reset Sequence

Selecting this menu entry will reset the sequential number that can
be used on orders. In most cases if you use the sequence number it
would be reset daily.

5.3 Logout

Activating the logout option will lock the system and prompt for
a new user code. You should note that this is an application level
control and has nothing to do with the system user login. Each users
preferences and physical layout of the application will be restored
when they log in.

5.4 Exit

Simply exits the TuxShop application, this can only be activated
from within a valid session and not while the system waits for a
login.
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6 The Edit menu

Whenever a letter is shown as Underlined a simple key press will
select that menu option.

Find Ctrl+F
Clients 4
Manage 4
Clear All Ctrl+L
Preferences ...

6.1 Find Ctrl+F

The find facility is used to activate the search engine for customers.
By default the Name field searched when Enter is pressed, all other
fields need activation with this option. The most common use is
to find clients based on account number or any detail in the Client
page. For example to locate all customers who have a 5% discount
simply enter 5 in the associated discount field then press Ctrl+F or
use the Edit -> Find menu option. You may also use the wild card
9% character, for example to locate all customers who have 5 or 5.x
use 5%.

You can use the % wild card in may ways, for example to find all
clients who have phone numbers like xxx 375 xxxx or 375 xxxx or
375x xxx the key would be to locate phone numbers containing 375
so we would use %375%
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6 The Edit menu

6.2 Search on S/N

This facility enables you to locate an invoice containing an item
with a specified serial number. Once located the matching invoice
is displayed. Note the serial number search does NOT support wild
cards.

6.3 Clients

6.3.1 Merge

This facility allows you to merge two account into a single account.
For example Miss Swan marries Mr Gander, and now they would
like a single account to Mr Gander. Perform the following actions.

Select Miss Swan in the name field, now use the Merge menu op-
tion, next select Mr Swan in the name field and again use the Merge
menu option. Miss Swan’s account will now be taken over by Mr
Ganders account. Of course dialogues guiding you and confirming
your actions will be presented as you proceed.

6.3.2 Purge

When you choose to purge a client from your system, all records
relating to that client will be removed. Before the actual purge takes
place you will be offered the chance to print out records of the client
to keep on file.
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6.4 Manage

6.4 Manage

6.4.1 Departments

e,
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You may add as many departments as are required, however it may
be prudent to think about operation of the touch interface and the
number of levels that may be required to navigate. The order of the
Departments on the touch panel can be adjusted using the Up and
Down rank buttons. The touch display is populated from left to right
and top to bottom.
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6 The Edit menu

6.4.2 Inventory

Figure 6.2: Inventory

i TuxShop - Stock Management ’;

e F———
uoM DTR Department | PIZZAS ~ | Touch Label _
instock [ | reorere arder Qty. on Order
Supplier | OFFICE =) Department Fiter [prezas .|~

Pricing Assitant Returnable Cost Markup Sales Price _ X VAT @ ()

Code Department Desmptmn UOM Cost Price  Sales Price  In Stock Touch Label Icon Rank |VAT |*

1 PIZZAS PIZZA - MARGHERITA 10.96 17.50 5.00 MARGHERITA  K__) |1 ool

3 PIZZAS PIZZA - HAWAIIAN 1533 24.47 5.00 HAWALIAN D g

5 PIZZAS PIZZA - REGINA 15.88 25.34 5.00 REGINA &b ¥

7 PIZZAS PIZZA - ROCK & ROLL 16.43 26.22 5.00 ROCK & ROLL g

o PIZZAS PIZZA - THAI 17.54 27.98 5.00 THAL ¥

11 |przzas PIZZA - CARIBBEAN 17.54 27.98 5.00 CARIBBEAN Yo =

Al 4
sl T

When inserting new entries the code must be unique, product bar
codes can be used with TuxShop, or you may choose a simple as-
cending number. If left blank TuxShop will try choose the next se-
quential number automatically. The unit of measure is used in the
invoice and the audit history.

The Cost, Markup, Sell exc. and Sell inc. fields all work together,
in addition if Tax’s are enabled the Tax check buttons affect the Sell
inc. Fields. When the tax, cost or markup of an item is changed
the two sell fields will automatically update to reflect the new sales
price. In practice it often occurs that the final selling price becomes
something like R146.01 this causes change problems for typical
cash items such as bags of dog food. In this case you might elect to
adjust the selling price by hand to R146.00 bear in mind that coupled
with your tax rate it may not be possible to get a rounded number.
For example with a TAX rate of 14% and a selling price or R148.24
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6.4 Manage

the total inclusive would be R168.99, changing the selling price to
R148.25 would result in a selling price of R169.01

You adjust the price by modifying the Sell exc. Field, as you modify
this field, the Sell inc. price will update. You will also notice that
the Sell exc. field changes colour to red, this is to warn you that the
price has been modified, and is not the same as the automatically
calculated price.

It is also possible to adjust the final selling price including VAT.
When adjusting this field the ENTER key must be pressed to force
an update of the Sell exe. field.

When deleting, updating, or creating new entries dialogues will con-
firm your requested action, and warn you when data will be changed.
Errors are also reported via dialogues, get into the habit of read-
ing the messages in these dialogues as they are there to prevent un-
wanted actions from destroying your data.

The supplier field its possible entries from the list of suppliers that
is managed in the Supplier panel. The use of this field is critical if
you wish to use the automatic stock control and ordering facilities
of TuxShop.

To disable stock control on any items adjust to Order Qty. to 0, this
will inform the system that no stock control on this item is required.

For services such as annual licenses that should be re-purchased it is
possible to set the DTR (Days to Renewal) field to contain the num-
ber of days till the repurchase is required. For example an annual
license would be set to 365. Using the File, Mail, Renewal menu
option the system will automatically produce a Renewal Reminder
within 20 days of the renewal expiry date. These reminders are used
to preempt your clients to purchase a renewal of the item or service.

The order of the Inventory items on the touch panel can be adjusted
using the Up and Down rank buttons. The touch display is populated
from left to right and top to bottom.
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6 The Edit menu

By using the Department filter you can choose to display only in-
ventory items that exist in the selected department. This is useful
when you have a large number of stock items.

6.4.3 Orders

Activating this option will check all Merchandise stock levels and
generate order forms for suppliers who’s product ranges are below
the re-order level. The system will not re-order items already on
back-order.

When the document is presented for printing the behavior is iden-
tical to that of Invoices and Receipts in that the Close option will
cancel the request, all other options will result in the system assum-
ing the transaction is completed.

6.4.4 Suppliers

The supplier page provides simple record management of the sup-
pliers of Merchandise to your business. The Company field is used
in Merchandise management to ensure that automatic order forms
can be created.
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6.5 Clear All Ctrl+L

Figure 6.3: Suppliers
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All the fields are self explanatory, but beware unlike other fields
there is no automatic formatting so care should be used to enter data
in a manner that will produce acceptable printouts. For example we
suggest using "Hills" vs. "hills”

6.5 Clear All Ctrl+L

The Clear all facility clears the interface and places the system in
a state read to start new transactions. All references to previously
access accounts are cleared. This is mostly used after invoicing to an
account that has a credit option and will pay later, when the Receipt
page is raised, Ctrl+L will ready the system for the next customer.

6.5.1 Preferences

This will activate the Preferences dialogue, see section ??
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7 The View menu

Whenever a letter is shown as Underlined a simple key press will
select that menu option.

[ Statement

Journal
Audit
Reports *

7.1 Statement

Activating this facility will display a statement for the currently se-
lected client. This will be done even if that clients balance is 0 or
in debit. This is an extremely fast and simple technique to confirm
inquiries from clients as to their account status.

7.2 Journal

Activating this facility will display a journal trail of Invoices and
Receipts for the currently selected client. The trail can be printed or
emailed if required.
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7.3 Audit

Activating the Audit trail will present a document containing a com-
plete and detailed trail of all transactions made with the currently se-
lected client. In addition your private notes will also be displayed in
this trail. The audit trail is your tool for sorting out possible conflicts
with clients over purchases and payments.

Your private notes could be useful in reminding you of promises you
or your staff might have made that now only your client remembers.

7.4 Reports

Services Performance
New Clients

Client Purchases
Client Expenadture
Client Debt
Commisons

Stock Levels
Recieved Stock Audit
Actions

The reporting functions of TuxShop assist you in your management
of your company. If you require additional reports and functionality
you should lodge a feature request with us at info@tuxsoft.co.za

Reports fall into to main categories, historical reports and current
reports. Historical reports provide you with comparisons over a six
month period. When presented with the date selection for historical
reports the date selected is month 6 of the six month period. For
current reports it is the month for that report.
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Figure 7.1: Date selection
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In addition historical reports can have items selected to chart for a
visual comparison of these results.
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Figure 7.2: Charting Reports
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To Chart Items simple select and highlight the entries required then
click the Chart Button.

7.4.1 Merchandise Performance

The merchandise report will generate a historical comparison of
merchandise sold over a six month period until the date selected.
The merchandise report supports charting of your results. Click-
ing on the column titles will sort the list of items according to that
column. A second click reverses the sort order.
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Figure 7.3: Merchandise Performance
A TuxShop Reporter

Merchandise Report

Description 2004-04 2004-05 2004-06 2004-07 2004-08 2004-09 ~ *
APPLETISER

SALAD - GREEK

SUBS - THAI **LARGE**

PIZZA - HAWAIIAN

PIZZA - DELUX CHEESE BURGER *
GARLIC PITA

DESERT - MEGA ICE CREAM

COKE

CHOCOLATE DOUBLE THICK SHAK
'VANILLA SHAKE

VANILLA DOUBLE THICK SHAKE
TOMATO COCKTAIL

=T

NNNNNNNDRO

SUBS - VEGETARIAN **LARGE**

SUBS - VEGETARIAN

SUBS - TUX DELUX **LARGE**

SUBS - TUX DELUX

SUBS - THAIL

SUBS - CLUB **LARGE**

SUBS - CLUB @

7.4.2 Services Performance

These services report will generate a historical comparison of ser-
vices rendered over a six month period until the date selected. The
services report supports charting of your results. Clicking on the
column titles will sort the list of items according to that column. A
second click reverses the sort order.

7.4.3 New Clients

The new clients report will generate a historical comparison of the
number of new client your business has registered over a six month
period until the date selected. The new clients report supports chart-
ing of your results. Clicking on the column titles will sort the list
of items according to that column. A second click reverses the sort
order.
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7.4.4 Client Purchases

The client purchases report is a current report that gives the items
purchased per client for the selected month. This may be useful in
deciding which clients should be sent information on a promotion
you may be having.

hat gives the items purchased per client for the selected month. This
may be useful in deciding which clients should be sent information
on a promotion you may be having.

Figure 7.4: Client Purchases

o
Clients Purchases Report
Client ~ Account No. | Description Quantity &
A. APPLE 12 APPLETISER 6
A. APPLE 12 CHOCOLATE DOUBLE THICK SHAKE 2
A. APPLE 12 COKE 2
A. APPLE 12 DESERT - MEGA ICE CREAM 2
A. APPLE 12 GARLIC PITA 2
A. APPLE 12 PIZZA - DELUX CHEESE BURGER **_ARGE** 2
A. APPLE 12 PIZZA - HAWAIIAN 2
A. APPLE 12 SALAD - GREEK 4
A. APPLE 12 SUBS - THAI **LARGE** 2
B. BEN 13 APPLETISER 6
B. BEN 13 CHOCOLATE DOUBLE THICK SHAKE 2
B. BEN 13 COKE 2
B. BEN 13 DESERT - MEGA ICE CREAM 2
B. BEN 13 GARLIC PITA 2
B. BEN 13 PIZZA - DELUX CHEESE BURGER **LARGE**2
B. BEN 13 PIZZA - HAWAIIAN 2
B. BEN 13 SALAD - GREEK 4
B. BEN 13 SUBS - THAI **| ARGE** 2
CASH 1 APPLETISER 6
CASH 1 CHOCOLATE DOUBLE THICK SHAKE 2 El

Use the column heading to sort by Client, Description or Quantity.
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7.4.5 Client Expenditure

7.4 Reports

The client expenditure report is that gives the total expenditure per
client for the selected month. This may be useful in determining dis-
count offering for clients based on expenditure rather than frequency

of visits.

Figure 7.5: Client Expenditure

Clients Expendature Report

Client - Account No. Expendature
A. APPLE 12 15.96
B. BEN 13 75.54
D. DUCK'O 15 67.92
R. LINDER 11 35.48
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7.4.6 Client Debt

A report that is useful for the terrible task of collection of moneys
outstanding. All clients with outstanding debt are shown. Those
who are overdue are shown in red. In addition the contact details for
the clients are shown.

With business’s that have a common client base this list can be used
as a shared list of clients who have bad debt.

7.4.7 Commissions

Figure 7.6: Commissions

A -# TuxShop Reporter
Sales Commission Report
Sales Person =~ Total Sales. Commission
Ross _______[170.96 17.10
Ross 341.92 34.19

The commissions report presents a table of commission due to your
sales personnel. Entries shown in Red are on sales made but not yet
paid for.
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7.4 Reports

7.4.8 Stock Levels

Figure 7.7: Stock Levels

%% TuxShop Reporter
Stock Levels Report
Code ~ Description UoM Quantity On Order Hand Count | &
0 Pizza - Margherita 5.00 0.00
1 Pizza - Margherita 5.00 0.00
2 Pizza - Margherita **Large** 5.00 0.00
3 Pizza - Hawaiian 4 0.00
4 Pizza - Hawaiian **Large** 5.00 0.00
5 Pizza - Regina 5.00 0.00
6 Pizza - Regina **Large** 5.00 0.00
7 Pizza - Rock & Roll 5.00 0.00
8 Pizza - Rock & Roll **Large** 5.00 0.00
9 Pizza - Thai 5.00 0.00
10 Pizza - Thai **Large** 5.00 0.00
11 Pizza - Caribbean 5.00 0.00
12 Pizza - Caribbean **Large** 5.00 0.00
13 Pizza - BBQ Roast Chicken 5.00 0.00
14 Pizza - BBQ Roast Chicken **Large** 5.00 0.00
15 Pizza - Vegetarian 5.00 0.00
16 Pizza - Vegetarian **Large** 5.00 0.00
17 Pizza - Delux Cheese Burger 5.00 0.00
18 Pizza - Delux Cheese Burger **Large** 4 0.00
19 Pizza - Club 5.00 0.00 @

The stock levels report presents a list of stock, the quantity on hand,
the quantity on order, and an empty slot to fill in hand count for
reconciliation.

7.4.9 Received Stock Audit

This report is unique in that it presents documents for printing or
viewing. Whats more it may present multiple documents in succes-
sion. In fact one document for each delivery that took place during
the selected month.
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7 The View menu

Figure 7.8: Received Stock Audit

A& TuxShop

Sales Person: Ross
OLYMPIC PROMO HAS ENDED.

Receieve Stock Trace Report

Date: 2004-09-18

Qty.

uoMm

Description

COCACOLA CO.

96

COKE

* Print F

| Process |

B close |

Notes for the delivery are shown in mauve, subsequent suppliers are

grouped and highlighted fore easy identification.

7.4.10 Actions

The actions report is a log of all activity that has taken place ex-
cluding normal sales and invoicing operations, discounts and price
changes are logged. The actions log is intended to help you keep
tabs on your staff and locate any abnormal behavior. It can clearly
indicate when staff are having problems with various aspects of your
business or the use of TuxShop. After viewing the log you may op-

tionally clear it.
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8 The Help menu

8.1 Contents ...

This presents an online version of this users guide.

8.2 About

Figure 8.1: Help About

Tuxshop Professional - Point Of Sale System

3
1 TuxShop Professional Ver 2.0
- Copyright ©2004-2007 Sue & Ross Linder
.

Linux(tm) Release

Registerd to Tasty TuxShop, 1 Tills
Expires on 2007-06-01

The help about dialogue presents information on the logged in user,
their default cash account, and your license or lease status.
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9 System Customisation

In this chapter we describe how you can customise various aspects
of TuxShop to suit your environment.

9.1 Creating a new language

You can select the language that each user will have the TuxShop
GUI operate in from the Personnel page in the Preference dialogue.

Before a language can be chosen its message catalogue must be cre-
ated. This process is not complex, but is rather time consuming.
To create a new message catalogue or update an existing catalogue
follow these steps.

1. Change directory to /opt/tuxsoft/i18n/TuxShop (Windows use
C:\Program Files\TuxSoft\i18n)

2. Check if a message catalogue for your locale exists, if so pro-
ceed to step 4

3. Copy each of the template file to the required name matching
your locale. For example ..
cp 118n.ts af_ZA.ts

4. Run the application ‘linguist’ and open the newly created ’ts’
or existing catalogue file.

5. Add translations for all needed texts, Save and then Release
your translations.
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9 System Customisation

6. Change directory to /opt/tuxsoft/share/TuxShop

7. Copy the English directory to one with the name of your newly
created language. For example..
cp -a English af ZA
ofr...
xcopy /E English af ZA

8. Edit each of the document parts in your new folder translating
all strings as required.

9. Start TuxShop and select the new language in the SysInfo
page of the Preferences dialog.

9.2 Customising your Documents

TuxShop uses a versatile system for document printing. All docu-
ments are created from basic HTML templates. Note do not use Java
or Java Script they are unsupported. These template are divided into
three sections. WARNING DO NOT USE WYSIWYG HTML
TOOLS, USE ONLY A PLAIN TEXT EDITOR, USING MI-
CROSOFT TOOLS OR EXTENSIONS WILL BREAK YOUR
SYSTEM.

1. The Head - this contains the title, the client and your address
information, and the basic header for items to be added to the
document.

2. The Items - this contains a repeatable section that is used to
add items to the document.

3. The tail - this closes the document off and adds any footers
required.

Data is replaced into the documents by searching them for $key-

words embedded in standard HTML comments. For example <!—
$date—> might be replaced with 2004-09-04
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9.2 Customising your Documents

The existing documents are contained in /opt/tuxsoft/share/TuxShop/English
you can examine these an gain a clear idea of the principles used.

You can also commission us at Tuxsoft to customise your documents

to suite your requirements. If you have created a new language or

are using one of the onse supplied, replace English with the lan-

guage created, Eg. af ZA

In addition some templates are stored in TAX1 and the TAX2 fold-
ers, these are choosen depending on the tax selections made in Pref-
erences. The structure uses a fallback system falling back from
TAX2 to TAX1 and finally back to the template root, Eg. English.

The following Documents are available, all have the format of DocHead.html
Docltem.html and DocTail.html we do not recommend editing the
Audit, Journal, Stock, Cashup or Monthend classes.

9.2.1 Invoice

The Invoice has the following keywords, remember to embed with
<!-$keyword—>
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9 System Customisation

Table 9.1: Invoice Head Keywords

| Keyword | Description
logo Image source for fancy logo
number Document number
date localised date
datetime localised date and time
shortdate yyyy-mm-dd
time hh:mm:ss
acc Clients account number
client Clients name
postal Clients postal address
shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.
email Clients email address
alinel Address line 1 as in SysInfo
aline2 Address line 2 as in SysInfo
aline3 Address line 3 as in SysInfo
aline4 Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 Address line 6 as in SysInfo
aline7 Address line 7 as in SysInfo

’ sequence \ sequence number of the day (Order number) ‘
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9.2 Customising your Documents

Figure 9.1: Invoice Item Keywords

Keyword Description |
quantity The number of items
iquantity Integer number of items.
uom Unit of Measure

department | The department of the item

description | The description of the item

date localised date
datetime localised date and time
shortdate yyyy-mm-dd

time hh:mm:ss

price the price of the items(s)

unitprice | The unit price of the item.

category The category of the item

discount The discount given
tax1 Y or N to indicate taxable
tax2 Y or N to indicate taxable

taxflags | * = Tax1, # = Tax2, exempt
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9 System Customisation

Table 9.2: Invoice Tail Keywords

Keyword Description
tax1 Value in % of tax1
tax Iname Name of tax Eg. VAT
tax 1total Value of tax1
tax2 Value in % of tax2
tax2name Name of tax Eg. GST
tax2total Value of tax2
subtotal | Total excluding taxes in Exclusive mode
total Total including taxes
exctotal Total of tax exempt items
excltotal Total of tax1 exempt items
exc2total Total of tax2 exempt items
invfootl Invoice Footer as in SysInfo
invfoot2 Invoice Footer as in SysInfo
cashier Name of the personal logged in.
date localised Date of transaction
datetime | Localised date and time of the transaction
shortdate yyyy-mm-dd
time hh:mm:ss
sequence Order number
number Invoice number
acc Account Number
client Client name

9.2.2 Quote

The Quote has the following keywords, remember to embed with
<!-$keyword—>
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9.2 Customising your Documents

Table 9.3: Quote Head Keywords

| Keyword | Description
logo Image source for fancy logo
number Document number
date localised date
datetime localised date and time
shortdate yyyy-mm-dd
acc Clients account number
client Clients name
postal Clients postal address
shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.
email Clients email address
alinel Address line 1 as in SysInfo
aline2 | Address line 2 as in SysInfo
aline3 Address line 3 as in SysInfo
aline4 Address line 4 as in SysInfo
aline5 | Address line 5 as in SysInfo
aline6 | Address line 6 as in SysInfo
aline7 | Address line 7 as in SysInfo
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Figure 9.2: Quote Item Keywords

| Keyword | Description
quantity The number of items
iquantity Integer number of items.
description | The description of the item
price the price of the items(s)
unitprice | The unit price of the item.
category The category of the item
discount The discount given
tax1 Y or N to indicate taxable
tax2 Y or N to indicate taxable
taxflags | * = Tax1, # = Tax2, exempt




9.2 Customising your Documents

Table 9.4: Quote Tail Keywords

Keyword Description
tax1 Value in % of tax1
taxIname Name of tax Eg. VAT
tax1total Value of tax1
tax2 Value in % of tax2
tax2name Name of tax Eg. GST
tax2total Value of tax2
subtotal | Total excluding taxes in Exclusive mode
total Total including taxes
exctotal Total of tax exempt items
excltotal Total of tax1 exempt items
exc2total Total of tax2 exempt items
invfootl Invoice Footer as in SysInfo
invfoot2 Invoice Footer as in SysInfo
cashier Name of the personal logged in.
date Date of transaction

9.2.3 Receipt

The Receipt has the following keywords, remember to embed with
<!-$keyword—>
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Table 9.5: Receipt Head Keywords

| Keyword | Description |
logo Image source for fancy logo
number Document number
date yyyy-mm-dd
acc Clients account number
client Clients name
postal Clients postal address
shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.
email Clients email address
alinel Address line 1 as in SysInfo
aline2 | Address line 2 as in SysInfo
aline3 | Address line 3 as in SysInfo
aline4 | Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 | Address line 6 as in SysInfo
aline7 | Address line 7 as in SysInfo

Figure 9.3: Receipt Item Keywords

Keyword Description
description | The description of the item
payment The amount paid




9.2 Customising your Documents

Table 9.6: Receipt Tail Keywords

| Keyword | Description
tender Total amount tendered
change Change due
outstanding | Outstanding amount on account
recfoot Receipt footer as in SysInfo

9.2.4 Statement

The Statement has the following keywords, remember to embed
with <!-$keyword—>
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Table 9.7: Statement Head Keywords
| Keyword | Description |
logo Image source for fancy logo
number Document number
date yyyy-mm-dd
acc Clients account number
client Clients name
postal Clients postal address
shipping Clients shipping address
phone Clients phone number
cell Clients cell phone number.
email Clients email address
alinel Address line 1 as in SysInfo
aline2 | Address line 2 as in SysInfo
aline3 | Address line 3 as in SysInfo
aline4 | Address line 4 as in SysInfo
aline5 Address line 5 as in SysInfo
aline6 | Address line 6 as in SysInfo
aline7 | Address line 7 as in SysInfo
Figure 9.4: Statement Item Keywords
Keyword | Description
date yyyy-mm-dd
description | The description of the item
amount | The value of the transaction




9.2 Customising your Documents

Table 9.8: Statement Tail Keywords

| Keyword | Description
total Total for the statement
current Current balance
day120 120+ Day balance
day90 90 Day balance
day60 60 Day balance
day30 30 Day balance
statefoot1 Statement footer as in Syslnfo
statefoot2 Statement footer as in SysInfo
statefoot3 Statement footer as in SysInfo
handed | Message if account handed for collection, blank if not.

9.2.5 Slip and ASCII printers

There are a few very basic features that may be used when creating
forms for your slip or ASCII printer. In the preferences editor you
can define codes for BOLD on, BOLD off, Emphasised on and Em-
phasised off text modes, the template files have the extension .slip
and .slip40

Here are some examples for an HP laser or deskjet.

Table 9.9: HP slip codes
BOLD ON 27,40,115,49,66
BOLD OFF 27,40,115,48,66

EMPHASIZED ON | 27,40,115,49,83
EMPHASIZED OFF | 27,40,115,48,83

An example of an Epson FX series printer
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9 System Customisation

Table 9.10: Epson FX slip codes
BOLD ON 27,71
BOLD OFF 27,72

EMPHASIZED ON | 27,69

EMPHASIZED OFF | 27,70

An example for Epson ESC/POS slip printers

Table 9.11: Epson ESC/POS slip codes
BOLD ON 27,71,33
BOLD OFF 27,72,32

EMPHASIZED ON | 27,69,33

EMPHASIZED OFF | 27,70,32

Text justification

It is also possible to justify parameters to some extent in the slip
templates, to left justify to a given with use the following format.
[-38] <!—--Sowner—-> to right justify use the following format
[38]<!--$%alinel-——>

So for example you template might include the line..
[-38]<!--$owner-->[38]<!--$alinel-->

This would place the owners name on the left of the page and the
name of your practice on the right.

Embedding Codes

You can also embed printer specific codes into your documents us-
ing the &codeé& facility. A common use would be in the tails of
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9.2 Customising your Documents

documents where one would like the printer to form feed the page.
In this case we would simply use the code &12& at the end of out
template.

You could also use this technique to set your page length, cut the pa-
per, or even print the document type in a larger font. The embedded
codes however have no effect on the preview dialogue.

Comments

Slip templates now support comments using the standard # as a com-
ment indicator. The # must be the first character in a line for that line
to be treated as a comment.
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License

This document and associated software are copyright © 2007,2008
TuxSoft CC. All rights reserved.

Granted Rights

You may install and distribute this software freely provided that the
complete package is distributed and all credits to TuxSoft remain,
including information on where license and leases may be obtained.

Limitations of Liability

In no event shall the developers or copyright holders be liable for
any damages whatsoever, including - but not restricted to lost rev-
enue or profits or other direct, indirect, special, incidental or conse-
quential damages, even if they have been advised of the possibility
of such damages, except to the extent invariable law, if any, provides
otherwise. Warranty The Software and associated documentation
are provided AS IS with NO WARRANTY OF ANY KIND, IN-
CLUDING THE WARRANTY OF DESIGN, MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE.
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